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Converting from Different Formats 
The list below indicates some options of how to handle various e-text formats. For 
PageMaker, Quark, and EPS, you will not be able to access them without the 
proper programs. Sometimes, even when you have the program, scanning from 
scratch can be the fastest choice. In fact, if you have a high-speed scanner, you 
are often better off scanning than waiting for files from the publisher. 
 

PageMaker 
Adobe PageMaker required for access 
PDF 

copy and paste 

EPS to TIFF 

Quark 
QuarkXPress required for access 
PDF 

copy and paste 

EPS to TIFF 

RTF 
open through Word 

ASCII 
open through Word and save in Word or RTF formats 

PDF 
read with Kurzweil 1000 

change to text with OmniPage Pro 11.0 

change to text in Acrobat 

HTML 
open through Word 
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Steps in Creating E-text 

 1. Remove the binding from the text. (Check to see if your campus print shop has a 
"guillotine.") 

 2. Scan the book a chapter at a time. 

 3. Scan to a multipage TIFF file. 

 4. For Kurzweil, open the TIFF in the Kurzweil Scan/Read station and save as a KES 
document. Once the file is in the KES format, you can open it on any Kurzweil 
system. 

 5. For other e-text uses, such as Braille, run the TIFF through an OCR program. 

 6. Strip out headers and footers, but make sure to retain page numbers. 

 7. Delete graphics for now, but if possible, retain the captions for figures that are 
referenced in the text. 

 8. If you are doing a math or science book, don't worry if the equations get lost, you 
can add them later. 

 9. If you have a foreign language text, make sure to set the OCR program's language 
feature to include that language.  

 10. Use the OCR program's proofreading capabilities to clean up the text as much as 
you can. 

 11. Save the resulting file to Microsoft Word. 

 12. Use the MS Word styles to prepare the document for Duxbury or large print, etc. 

 13. Rebind the student’s book to return to him/her. 

Step One 
Get in the habit of checking Louis and the HTCTU Alternate Media Exchange 
(AMX) Database before ordering e-text and before producing braille or recording a 
book. Someone else may already have done the work! 
 
Louis database at www.aph.org 
 
AMX at www.htctu.fhda.edu 
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TIFF Scanning 
When you scan a black and white page, your scanner automatically creates a 
TIFF file, which is a graphic. The scanner works in essentially the same way that a 
copy machine does; in other words, the scanner takes a picture of the page. 
However, rather than making a hardcopy picture of the page, it makes a digital 
picture, a TIFF.  
 
When you do your scanning, you can use a scanning utility (Scanning Utility 5000 
comes with the Canon scanner) or a program such as Adobe PhotoShop. You can 
also scan directly into Kurzweil. 
 
Scanning utilities are usually the best option for production as they can handle 
auto feed and multiple pages in a document. If you are scanning using Kurzweil, 
an excellent overview of TIFF scanning can be found at the following Web site: 
http://www.indiana.edu/~iubdrh/etext/k3000prep.htm 
 
The ultimate use for your e-text will determine what you do with the TIFF file. If you 
want to use the TIFF in Kurzweil, you can open it on the Kurzweil Scan/Read 
station and save it as a KES format. The KES format can then be opened on any 
Kurzweil station. 
 
If you are taking your file into electronic text in preparation for creating Braille or 
large print, you will need to extract the text from the picture by running optical 
character recognition on the file using an OCR program. There are a number of 
OCR programs on the market, but OmniPage Pro and Fine Reader are two of the 
best. 
 
We recommend scanning first to TIFF then opening your document in the OCR 
program. This process is more stable than scanning directly into the OCR 
program. Also this process will allow you to save your TIFF file. We recommend 
archiving the TIFF for later conversion to a different file format. 
 
For those of you using the Canon 5080C, we have found that the best scanning 
settings for keeping the graphics is Black and White ED at 400 DPI. If you open 
the TIFF file in Kurzweil Scan/Read, you can enhance your results by using the 
Kurzweil "despeckle" feature. 
 
If you only want the text, the best setting is Black and White at 300 DPI. 
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Create Folders for Scanning 
Before you begin scanning, create a folder of scanned books, and within that 
folder create a template that you can copy and rename every time you scan a new 
book. The template should have folders for front matter, chapters, and back matter 
within a folder that will be named for the book. 
 

Level One Level Two 

  
 

OCR Processing 

We recommend OmniPage Pro or Abby FineReader for your OCR processing. 
When you scan, you take a picture of the page. Running OCR (optical character 
recognition) on the scanned document means using a program that compares 
what it finds on the page to what it holds in memory as known shapes for text. The 
cleaner and clearer the copy, and the fewer the graphics and symbols in the text, 
the better the text recognition will be.  
 
Be aware that even though it might look like the Kurzweil program would be more 
accurate because it uses a TIFF (an exact picture), the Kurzweil, too, runs OCR 
on the file. The only way to get scanned text into a form for editing is through an 
OCR process. 
 
To prepare a book for multi-page scanning, you will need to tear it apart. Check 
with your campus print shop to see if they have a guillotine for removing the spines 
from books. Also check to see whether they have a comb-binding system or some 
other binding procedure for putting the pages back together when you're finished. 
(Some print shops will even do the scanning for you!) 
 
Your campus may wish to develop a policy that when you are scanning (brailling, 
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enlarging), you will only do the chapters of the book required for the class. You 
may also wish to have a policy that you will only scan books that have not been 
highlighted. 

Scanning 
Again, we recommend that you scan to TIFF using scanning software and then run 
optical character recognition on the scanned image. 
 
Adjusting scanner values 

manual vs. automatic (single pages or multiple pages) 

simplex vs. duplex (single sided vs. double sided) 

(Note: It is possible to get true duplex running the Canon scanner under 
OmniPage Pro. If you're not getting true duplex in that program, go to Setup and 
try another driver. You will have at least two listed.)  

Multiple scanners 
You can have more than one scanner hooked onto your computer so that you can 
do flatbed or high-speed scanning. 

Mode 

Black and white—for text, music, and line drawings; photos will not be 
rendered well 

Grayscale—for black and white photos, text on colored background 

Color—color drawings, graphics, or photos (only on color scanners) 

Resolution 

300 dpi (dots per inch) for black and white; 400 dpi for black and white ED— 
More is not necessarily better when scanning text; for example, if you are 
scanning text on thin paper, scanning at high resolution may pick up bleed-through 
text from the back of the paper, whereas dropping the dots per inch down, maybe 
even to 200 dpi or 150 dpi, may result in a better scan. 

Page thickness 
Don't mix different thicknesses of paper. If you are feeding glossy or thin paper, 
you may need to adjust your feeder. 

Contrast 
Contrast is a measure of how much difference there will be between light and dark 
parts of an image. OCR quality depends heavily on good brightness and contrast 
settings. Not all scanners allow manual adjustment of contrast. 
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Brightness 
Brightness is a measure of how dark or pale a scanned image will be. OCR quality 
depends heavily on good brightness settings. An image where letter shapes run 
together is too dark. When letter shapes are thin or broken, the image is too light. 
Many scanners have an auto-brightness feature. 

Colored backgrounds 
Use the grayscale setting. You may need to decrease the brightness setting of the 
scanner. You may also need to check the contrast. 

Strange fonts 
In OmniPage, the IntelliTrain option allows the program to learn as you edit. It will 
remember the letters it did not recognize. This feature is very useful when 
scanning unusual fonts. 

 
Different languages 
Choose all the languages that are in the document. For math, you may find it 
helpful to include Greek among the languages so that the OCR program is able to 
recognize the Greek symbols used in mathematics. 

Beyond the Basics in OmniPage Pro 

Understanding zones 
Zones allow you to tell OmniPage where on the page you want it to recognize text 
and where you want it to ignore text. This process allows you to strip out headers 
and footers while keeping the page numbers. It also allows you to tell the program 
not to look for text in graphics. 
 
You can save your zone configuration as a template, and use that template to 
scan a book. Setting up a template in the first place takes a bit of time, but in the 
long run, it will save you more time. 
 

Creating a template 
We start out by scanning a few test pages using the manual setting. Once the 
scanning is complete, just say "No" to the save as window. 
 
If you let OmniPage find the zones itself, it will see each block of text as a 
separate entity. You want it to view the text as a continuous stream.  

 
The template will have areas for the page number on left-hand pages, the page 
number on right-hand pages, the main block of text, and the area where we tell the 
program to ignore what is in that space (the header).  
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When you scan the rest of the book, you load the template you have created, and 
the text blocks come through very cleanly with very little editing required. 
 

Text Boxes 
You can bring text from OmniPage into Word in various configurations. If you ask 
OmniPage to retain the structure of the original text page, it will. However, in order 
to do so, it uses text boxes. These text boxes can be difficult to work with. A 
simpler option is to change the view in the text editor window to "Retain fonts and 
paragraphs." This option brings the text into Word as a continuous stream of text. 
 
To check or change your settings, go to View > Text Editor View > Retain Fonts 
and Paragraphs. 
 

Tables 
You can tell OmniPage that it is scanning a table, and it will recognize the rows 
and columns. Use the table controls to adjust rows and columns. When you take 
the document into Word, the table format is carried through. 

 

Reading PDF 
OmniPage can read PDFs. It runs a virtual scan on them and recognizes the text. 
Once you have the text in OmniPage, you can save it as an ASCII or Word file. 
 

Creating PDFs 
One of the tools that OmniPage provides is the option to schedule OCR 
processing. If you have Adobe Acrobat on the machine, this same tool can be 
used to schedule automatic conversion of documents to PDF. 

MS Word 
Be aware that when you take text from OmniPage into Word, you may find that 
some of your text disappears. What has happened is that the spacing and font 
size are pushing text off a page, adjust the formatting and you will see the text 
again. 
 

Cleaning up Hyphens 
OmniPage sees the hyphens that fall at the ends of lines and includes them in the 
text that goes into Word. To delete these hyphens, search for "optional hyphens" 
(^-) and replace them with nothing. 
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File Structure 
How you set up your e-text files is very important. Make sure that chapters are 
separated and clearly marked. Make sure that the table of contents and index are 
in separate files and can be found easily. The organization and naming convention 
used for the files and folders has an enormous impact on ease of navigation. 
 
Remember, if you use numbers, computers would put the numbers 1, 05, 200, 30, 
and 3 in the following order: 05, 1, 200, 3, 30. 

 

  
 

Improving Accuracy 

These hints are taken from the OmniPage Pro Help menu. 

Select settings that improve accuracy in the Options dialog box. 

Choose Options in the Tools menu then click the tab in the Options dialog 
box for the settings you want to change: 

Adjust the Brightness and Contrast sliders in the Scanner panel. 
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Brightness: A measure of how dark or pale a scanned image will be. OCR quality 
depends heavily on good brightness settings. An image where letter shapes run 
together is too dark. When letter shapes are thin or broken, the image is too light. 
Many scanners have an auto-brightness feature.  
Contrast: A measure of how much difference there will be between light and dark 
parts of an image. OCR quality depends heavily on good brightness and contrast 
settings. Not all scanners allow manual adjustment of contrast.  

If your only criterion is OCR accuracy, prefer black-and-white scanning for good 
quality documents with crisp black text on a white background. Choose grayscale 
scanning if you are scanning pages with text on colored or shaded backgrounds, 
or for degraded documents with low or varied contrast. 

Select Automatically correct page orientation in the Process panel. The program will 
then detect text direction on the page and rotate it accordingly. If a page appears 
the wrong way up, either rotate it manually or turn this option off before 
rescanning. Auto-detection may have difficulty on pages containing vertical text. 

Choose OCR Method More Accurate in the OCR panel. This will improve OCR 
accuracy, but may increase processing time, because two recognition engines will 
run. 

Select Training File (IntelliTrain) in the Proofing panel to use a character training file to 
help recognize special or stylized characters during OCR. 

Use suitable recognition aids 

• If you have a long document, and no suitable training file, do some training 
on a few typical pages. Turn on IntelliTrain in the Proofing panel of the 
Options dialog box, then recognize three or four pages and proofread the 
text. Inspect the quality of the training in the Edit Training dialog box, then 
save it to file. 

• If you are getting poor results with a training file loaded, check its contents 
in the Edit Training dialog box. Make sure it is appropriate for the current 
document. If it is not, either unload it or edit its contents to remove training 
from poorly formed character shapes. Unsuitable training can yield worse 
results than no training at all. 

• If proofing is skipping too many unsuitable words and you have a user 
dictionary loaded, check its contents with the Edit User Dictionary dialog 
box. Delete any entries added in error, especially misspelled words. 

Identify Zones Correctly 

• When processing pages manually, make sure zones are identified correctly 
before OCR. See Changing Zone Properties for more information. 

• When processing automatically, be sure your original layout setting is the 
best one for the document. Inspect the recognition results. If there are 
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defects due to poor zoning on some pages, change the zone properties 
and/or locations and rerecognize those pages. 

• Make sure you do not have a zone template file loaded which is unsuitable 
for your current pages. 

• To retain handwritten text, such as a signature, identify it as a graphic zone. 

Use High-Quality Images 

• In general, try to use original pages when you are scanning documents. 
Typeset, high-quality printed page images yield the best OCR accuracy. 
OCR accuracy may not be as good with lesser-quality pages. 

• With low-quality originals, sometimes a good-quality photocopy can yield 
better OCR results. This may be true on documents with low contrast or 
printed on thin paper. On the other hand, poor-quality photocopies with 
stripes, blotches or uneven brightness will usually give worse results. 

• Ask senders to select Fine or Best Mode when they send you a fax. 
• Page images should be free of notes, lines, or doodles. Anything that is not 

a printed character slows recognition, and any character distorted by a 
mark may be unrecognizable. Try not to include such marks in zones, or 
enclose them in an Ignore zone type. 

• Text in page images should be reasonably clean and crisp. Characters 
should be separated from each other and not blotched together or 
overlapping. 

• If you have influence over the styling used in documents you want to 
recognize, avoid having underlines used. It is difficult to recognize 
underlined text because the underline changes the shape of descenders on 
the letters q, g, y, p, and j. 

• If you are getting poor results from image files, check their quality and 
resolution by hovering the cursor over them in the Original Image area. The 
ideal resolution for OCR is 300 dpi. Images with less than 200 dpi or more 
than 400 dpi are liable to yield far lower accuracy. If you have the 
documents on paper, scan them again with better settings. If not, ask the 
people who supply your images to use 300 dpi. 

Create Folders for Scanning 
Create a folder of scanned books, and within that folder create a template that you 
can copy and rename every time you scan a new book. The template should have 
folders for front matter, chapters, and back matter within a folder that will be 
named for the book. 
 
 
 
 

 13 



Level One Level Two 

  

MP3 

Why use MP3? 
MP3 files finally give us a way to provide audio materials that students can use in 
class! An MP3 player uses the same sort of indexing-by-track system that is found 
on CDs. With this in mind, you can create separate MP3 files for each chunk of 
information that students might need to access; for example, for a student in a 
science lab class, you might record lab procedures, equipment requirements, and 
theoretical discussions on separate tracks. That way, the student can easily move 
to the appropriate track. 

TextAloud MP3 
http://www.textaloud.com 

http://www.nextup.com/TextAloud/SpeechEngine/voices.html 
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Kurzweil 1000 v. 6.0 

 

 

DAISY/NISO Standards 

DAISY/NISO 
http://www.loc.gov/nls/niso/dtbook3doc.htm 

DAISY (Digital Audio-based Information SYstem) Consortium 

The Digital Talking Book 3.0 Document Type Definition (DTD) provides the means 
to markup the text of a published book to permit support for the combination of 
professional narration, and navigation into that narration. The markup tags in the 
book convey its content in structure, and some metadata about the book content 
and its structures. 
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NISO (National Information Standards Organization) 
http://www.niso.org/commitaq.html 

Description of Standard: Currently, talking books for the visually impaired are 
distributed on audio cassettes. The next-generation technology for this application 
will be digitally based, bringing many improvements in sound quality, document 
navigation, and searching. The NISO Digital Talking Book (DTB) Standard will 
ensure compatibility among the many systems expected to be developed. The 
core of the standard will be the file specification, describing how the various 
functions of a DTB will be coded. Other portions of the standard will address the 
features desired in a DTB and describe the critical elements of the user interface 
of a DTB player.  

XML (Extensible Markup Language) 

DTB consists of three major parts: an audio file, which could be encoded in any of 
several standard audio codecs (compression/ decompression algorithms that allow 
enormous audio files to be greatly compressed); a text file (necessary for word 
spelling and text searches) with tags from a descriptive markup language 
inserted—XML (Extensible Markup Language); and a linking file that synchronizes 
the audio and text files, probably written in SMIL (Synchronized Multimedia 
Integration Language). 

NFF (National File Format) 
Publishers, individuals with print diabilities, and e-text service providers all 
recognize the need for a standardized format for producing electronic text. Under 
the auspices of the Department of Education, ANSI/NISO Z39.86-2002 DTBook 
has been adopted as the national file format. 
The following description is taken from the CAST Web site:  
http://www.cast.org/ncac/index.cfm?i=3192 

In describing DTBook, the "pizza" metaphor has been used to clarify the 
use of the base tag set and additional modules. One can think of the 
DTBook tag set as being a basic cheese pizza, and modules as toppings 
that can be added as desired. The DTBook tag set contains the common 
elements found in textbooks and reading materials used in the K-12 
arena. The over arching structures, such as front matter; headings for 
parts, chapters, sections, and sub-sections; rear matter, etc. are defined. 
Block-type elements, such as paragraphs, block quotes, lists, footnotes, 
sidebars, etc. are also defined. Inline items, such as emphasized text, 
acronyms, citations, footnote references, sentences, etc. are identified. A 
complete list of these can be found in the standard. The point here is 
that the basic types of books can normally be represented in XML using 
this basic cheese pizza. 

Now think of separate modules that can be added, as toppings on a 
pizza. A poetry module that would contain the tags needed to mark up 
poems is under development by the Z39.86 community. The community 

 16 



has also done preliminary work on a module for the markup of plays. 
These might be considered green peppers and onions for the pizza. The 
modules that can be added to the basic structure depend on the 
information one needs to convey. 

The World Wide Web Consortium (W3C), the standards setting body for 
the Internet, has used this modular approach as well. One topping we 
may consider adopting for our pizza is the work they have done with 
MathML: http://www.w3.org/Math/ 

This is a module we should consider using when providing information in 
the field of mathematics. This is definitely meat on the pizza! The work 
conducted in the W3C paid close attention to the needs of persons with 
disabilities, but there is a lot of work, requiring significant resources, that 
needs to be done with accessibility tools to take advantage of math 
provided in XML in this way. The math work has been discussed by the 
Z39.86 Advisory Committee, and we have demonstrated that a MathML 
segment can be incorporated in a DTBook document.  

Other modules will be required as time goes on, such as for other 
scientific disciplines, dictionaries, music, and so forth. The DTBook DTD 
was designed to meet the majority of the markup needs in non-technical 
books. It was deliberately kept lean so it would be easy to learn and use. 
The other modules to be developed would only be used as needed, thus 
minimizing complexity for users. DTBook incorporates a simple XML 
mechanism, described in section 4.2.2 of the standard and in the DTD 
itself, for incorporating tags from other element sets as needed 
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Sources of Free E-text 

Project Gutenberg 
http://promo.net/pg/ 

NetLibrary 
http://www.netlibrary.com/ 

E-Brary 
http://www.ebrary.com/ 

http://learningnetwork.ebrary.com/ 

MetaText Digital Textbooks 
http://www.metatext.com/ 

Bookshare 
http://www.bookshare.org/ 

University of Virginia 
http://etext.lib.virginia.edu/ 

National Library Services 
http://www.loc.gov/nls/ 

Kurzweil 
ftp://ftp.kurzweiledu.com/pub/classicliterature/ 

 

Sources to Check before Ordering Textbooks 

Louis Database 
www.aph.org 

AMX (Alternate Media eXchange) 
www.htctu.fhda.edu 
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BILL NUMBER: AB 422 CHAPTERED 09/15/99 

CHAPTER 37 
FILED WITH SECRETARY OF STATE SEPTEMBER 15, 1999 
APPROVED BY GOVERNOR SEPTEMBER 15, 1999 
PASSED THE ASSEMBLY AUGUST 26, 1999 
PASSED THE SENATE AUGUST 23, 1999 
AMENDED IN SENATE JUNE 30, 1999 
AMENDED IN SENATE JUNE 16, 1999 
AMENDED IN ASSEMBLY MAY 25, 1999 
AMENDED IN ASSEMBLY APRIL 5, 1999 
INTRODUCED BY Assembly Member Steinberg 
(Coauthors: Assembly Members Aroner, Corbett, Kuehl, and Thomson) 

FEBRUARY 12, 1999 

An act to add Section 67302 to the Education Code, relating to instructional materials. 

LEGISLATIVE COUNSEL'S DIGEST 
AB 422, Steinberg. Instructional materials: disabled students. 

Under existing law, a publisher or manufacturer of instructional materials offered for 
adoption or sale in California is required to comply with specified requirements, including 
providing to the state, at no cost, the right to transcribe, reproduce, and distribute the 
material in braille, large print, recordings, or other accessible media for use by pupils with 
visual disabilities. This right includes computer diskette versions of instructional materials 
if made available to any other state, and those corrections and revisions as may be 
necessary. 

This bill would require every individual, firm, partnership or corporation publishing or 
manufacturing printed instructional materials, as defined, for students attending the 
University of California, the California State University, or a California Community 
College to provide to the university, college, or particular campus of the university or 
college, for use by students at no additional cost and in a timely manner, any printed 
instructional material in unencrypted electronic form upon the receipt of a written request, 
provided that the university or college complies with certain conditions. 

This bill would require that the computer files or electronic versions of printed 
instructional material maintain their structural integrity, as defined, be compatible with 
commonly used braille translation and speech synthesis software, and include corrections 
and revisions as may be necessary. 

This bill would authorize the Chancellor of the California Community Colleges, the 
Chancellor of the California State University, and the President of the University of 
California to each establish one or more centers within their respective segments to process 
requests for electronic versions of instructional materials, as prescribed. 
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This bill would also require an individual, firm, partnership or corporation that publishes or 
manufactures nonprinted instructional materials for students attending the University of 
California, the California State University, or a California Community College to provide 
computer files or other electronic versions of the nonprinted instructional materials for use 
by students, subject to the same conditions for printed instructional materials, when 
technology is available to convert these nonprinted instructional materials to a format that 
maintains the structural integrity of the nonprinted instructional material that is compatible 
with braille translation and speech synthesis software. 

This bill would provide that willful failure to comply with these requirements would be 
subject to sanctions under the law relating to full and equal access of disabled persons to 
public accommodations. 

THE PEOPLE OF THE STATE OF CALIFORNIA DO ENACT AS FOLLOWS: 

SECTION 1. Section 67302 is added to the Education Code, to read: 

67302. (a) An individual, firm, partnership or corporation that publishes or manufactures 
printed instructional materials for students attending the University of California, the 
California State University, or a California Community College, shall provide to the 
university, college, or particular campus of the university or college, for use by students 
attending the University of California, the California State University, or a California 
Community College, any printed instructional material in an electronic format mutually 
agreed upon by the publisher or manufacturer and the college or campus. Computer files or 
electronic versions of printed instructional materials shall maintain the structural integrity 
of the printed instructional material, be compatible with commonly used braille translation 
and speech synthesis software, and include corrections and revisions as may be necessary. 
The computer files or electronic versions of the printed instructional material shall be 
provided to the university, college, or particular campus of the university or college at no 
additional cost and in a timely manner, upon receipt of a written request that does all of the 
following: 

(1) Certifies that the university, college, or particular campus of the university or college 
has purchased the printed instructional material for use by a student with a disability or that 
a student with a disability attending or registered to attend that university, college, or 
particular campus of the university or college has purchased the printed instructional 
material. 

(2) Certifies that the student has a disability that prevents him or her from using standard 
instructional materials. 

(3) Certifies that the printed instructional material is for use by the student in connection 
with a course in which he or she is registered or enrolled at the university, college, or 
particular campus of the university or college. 

(4) Is signed by the coordinator of services for students with disabilities at the university, 
college, or particular campus of the university or college or by the campus or college 
official responsible for monitoring compliance with the Americans with Disabilities Act of 
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1990 (42 U.S.C. 12101 et seq.) at the university, college, or particular campus of the 
university or college. 

(b) An individual, firm, partnership or corporation specified in subdivision (a) may also 
require that, in addition to the conditions enumerated above, the request shall include a 
statement signed by the student agreeing to both of the following: 

(1) He or she will use the electronic copy of the printed instructional material in 
specialized format solely for his or her own educational purposes. 

(2) He or she will not copy or duplicate the printed instructional material for use by others. 

(c) If a college or university permits a student to directly use the electronic version of an 
instructional material, the disk or file shall be copy-protected or the college or university 
shall take other reasonable precautions to ensure that students do not copy or distribute 
electronic versions of instructional materials in violation of the Copyright Revisions Act of 
1976, as amended (17 U.S.C. Sec. 101 et seq.). 

(d) An individual, firm, partnership or corporation that publishes or manufactures 
nonprinted instructional materials for students attending the University of California, the 
California State University, or a California Community College shall provide computer 
files or other electronic versions of the nonprinted instructional materials for use by 
students attending the University of California, the California State University, or a 
California Community College, subject to the same conditions set forth in subdivisions (a) 
and (b) for printed instructional materials, when technology is available to convert these 
nonprinted instructional materials to a format that maintains the structural integrity of the 
nonprinted instructional materials that is compatible with braille translation and speech 
synthesis software. 

(e) For purposes of this section: 

(1) "Instructional material or materials" means textbooks and other materials written and 
published primarily for use by students in postsecondary instruction that are required or 
essential to a student's success in a course of study in which a student with a disability is 
enrolled. The determination of which materials are "required or essential to student 
success" shall be made by the instructor of the course in consultation with the official 
making the request pursuant to paragraph (4) of subdivision (a) in accordance with 
guidelines issued pursuant to subdivision (i). "Instructional material or materials" does not 
include nontextual mathematics and science materials until the time software becomes 
commercially available that permits the conversion of existing electronic files of the 
materials into a format that is compatible with braille translation software or alternative 
media for students with disabilities. 

(2) "Printed instructional material or materials" means instructional material or materials in 
book or other printed form. 

(3) "Nonprinted instructional materials" means instructional materials in formats other than 
print, and includes instructional materials that require the availability of electronic 
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equipment in order to be used as a learning resource, including, but not necessarily limited 
to, software programs, video disks, and video and audio tapes. 

(4) "Structural integrity" means all of the printed instructional material, including, but not 
limited to, the text of the material, sidebars, the table of contents, chapter headings and 
subheadings, footnotes, indexes, glossaries, and bibliographies. "Structural integrity" need 
not include nontextual elements such as pictures, illustrations, graphs, or charts. If good 
faith efforts fail to produce an agreement pursuant to subdivision (a) between the publisher 
or manufacturer and the university, college, or particular campus of the university or 
college, as to an electronic format that will preserve the structural integrity of the printed 
instructional material, the publisher or manufacturer shall provide the instructional material 
in ASCII text and shall preserve as much of the structural integrity of the printed 
instructional material as possible. 

(5) "Specialized format" means braille, audio, or digital text that is exclusively for use by 
blind or other persons with disabilities. 

(f) Nothing in this section shall be construed to prohibit a university, college, or particular 
campus of the university or college from assisting a student with a disability by using the 
electronic version of printed instructional material provided pursuant to this section solely 
to transcribe or arrange for the transcription of the printed instructional material into 
braille. In the event a transcription is made, the campus or college shall have the right to 
share the braille copy of the printed instructional material with other students with 
disabilities. 

(g) The Chancellor of the California Community Colleges, the Chancellor of the California 
State University, and the President of the University of California may each establish one 
or more centers within their respective segments to process requests for electronic versions 
of instructional materials pursuant to this section. If a segment establishes a center or 
centers, each of the following shall apply: 

(1) The colleges or campuses designated as within the jurisdiction of a center shall submit 
requests for instructional material made pursuant to paragraph (4) of subdivision (a) to the 
center, which shall transmit the request to the publisher or manufacturer. 

(2) If there is more than one center, each center shall make every effort to coordinate 
requests within its segment. 

(3) The publisher or manufacturer of instructional material shall be required to honor and 
respond to only those requests submitted through a designated center. 

(4) If a publisher or manufacturer has responded to a request for instructional materials by 
a center, or on behalf of all the centers within a segment, all subsequent requests for these 
instructional materials shall be satisfied by the center to which the request is made. 

(h) Nothing in this section shall be deemed to authorize any use of instructional materials 
that would constitute an infringement of copyright under the Copyright Revision Act of 
1976, as amended (17 U.S.C. Sec. 101 et seq.). 
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(i) The governing boards of the California Community Colleges, the California State 
University, and the University of California shall each adopt guidelines consistent with this 
section for its implementation and administration. At a minimum, the guidelines shall 
address all of the following: 

(1) The designation of materials deemed "required or essential to student success." 

(2) The determination of the availability of technology for the conversion of nonprinted 
materials pursuant to subdivision (d) and the conversion of mathematics and science 
materials pursuant to paragraph (4) of subdivision (e). 

(3) The procedures and standards relating to distribution of files and materials pursuant to 
subdivisions (a) and (b). 

(4) Other matters as are deemed necessary or appropriate to carry out the purposes of this 
section. 

(j) Failure to comply with the requirements of this section shall be a violation of Section 
54.1 of the Civil Code. 
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